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1. [The Philippine National Development Plan
Progeam Master Planning 1698 NEDA
2. |Reportand Recommendition of the President to
the Boatd of Directors on Proposed Loans 1o the
Republic of the Philippines for the Rural Watse
. |Supply and Sanitation Sector Project May 1956 ADDB
3. |Repontand Recommendation of the President to
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4. lbng Term and Medium Tenn Sector Devit
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11. {Sociat Reform Agenda Policy Direclives Social Reform
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T S T SOCIOECONOMIC s
1. |Socio-Economic Prafile (Leyte) =
2. [Census-Based National ang Regional Population .
Projection Volume 1 - o 1995 NSO
3. [Repon No. 1-P: Population by Province, Cityf
Municipality and Barangay :
Region Vill 1995 Census 19935 NSO »
4. |Repont MNo. 2-87P: Sucio Economic and -
Demographic Characteristics Leyte 1995 Census June-03 NSO ]
5. Philippine Statistical Yearbook 1997 NSCi3
6 NSO Census by Pn;wince, Male, Feinale and
Age Brackel 1995 NSC |
7. [Geographic Coding and Urban and Runl
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2. |Master Plan Study on Water Resources )
Managemieat in Republic of the Philippines Vol. i Jan 1993 NWREB L
3. |Puilippine Water Resources Data Volume II ‘ R :
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4. |Philippine Water Resources Data Volume I : S o :
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7. [Rapid Assessment of Water Supply Scurces 1982 NWRB u
Leyte :
8. |Groundwater Resources Investigation Report Unpublished NwgRB -

Leyte

9. |water Resoucces Summary Data

{(Volume | and 2) : . 1970 NWRB ] _ é '
o i
10, JIndividual Well Inventory ‘ 1990 NWRER ]
Leyte
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12, [LWUA Water District Database 1957 LWUA -
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1. |Community Development Manuat : DPWH/DILG! -
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Water and Sanitation for All: A World Priority
Achizvenents and Challenges

Community Organizess’ Manual, Pari

A 1landbook on Conununity Development

Achiey iﬁg Sugsessin Caﬁununily Water Supply
and Saritation Projects

Handbook on (‘mnnmnilj Organizing for Water
Sanitation

Drafi Final Report for Special Assistance fog
Projects Sustalnability for the Rural Water Supply
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A Manual on Community Participation in Watec
Supply and Sanitation (RWSSP)

Achieving Success in Comnunity Waler Supply and
Sanilalion Proje-:ts
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Year " Source. [ G C R PR
1595 IRC Inteenational ]
Water & Sociz) Center
1950 CSWCD-URMDCD!
DOP
1975 up m
UNDYP L
MG ]
Feb. 1997 SAPS Team [ ]
|
1980 WHOQ =
PIC ]

Nov. 1995

i GERDI:R;

Sourcebook for Gender lssucs at the Policies Level

OcL 1996

in the Water and Sanitation Secior IOROAWD L
i. Gendet 135ucs Sourcebook for Water and Saniia- ‘
© [tion Projects Jan. 1695 IBRIVWAHR [
3. Too!hl on Ge_nder in Waler and Sanitation .
Series No. 2 Aug. 1996 UNDP L]
4. Domuhc Shallow Well Water Suppties the l-arm!y
llandpump Scenano Feb. 1990 uNDP n
5. |United Nations Decade for Women 1976-1985 L]
6 [Geader Moinstreaming NCRFW =
7. Rggioﬁal Memorandums Feb. l9§7 DILG [
§. |Phitippioe Flan for Gender Bevelopment 1995-2025 NC.RFW =
9. |Philippine Counlry Report on Women Sept. 1995. NCRFW =
10, |A Primer on the GAD Fosst Point 1996 NCRFW ]
748 DR FINANCIAL.
I Annual Tnvesimcnl Plans
Leyte PPDO
2.4 Family [nc@me and Expenditures Survey Vol § 1994 NSO =
.3. Family lncome and .Expendilures Survey Vol Il 1994 NSO ]
4. |DILG Memorendum Circular 96-263 1996 DILG -
S, |Presideattal Decree 1914 MDF) 1684 aP L]
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Joint Circular No. 6.87

LeyteAccomplishment Reports,
19931996

Statement of Income-Expenditures
of Municipalities

TAug 1987

1993-1996

ur¢ RILPF]TMT8]
nEM =
PPDO "
FPDO =

Legend:

ADE - Asizn Developrient Bank

BRC - Bareaa of Research and Siandards

CHWCD - Coltege 'of Social Work and Community Dcvciopﬁwnt
OCB - Depareat OICI‘:-mllltlﬁity Development

DEQ - Disuict Ernginccc Office

DILG - Depathncnt of Interior aod Local Gov crement

DO - Bepartinent of Flealih

DOEL - Development Oplions Philippines, Inc.

DEWH - Department of Weerks and Highways

IBRD - Intewationsl Bank for Reconstrclon and Dc{.c!:.-pmﬂrt
LGU - Locat Gowmnwnt it

LWUA - Local Water Ummcs Adurinisuation

MAMRIA - Natioal szpmg & Resource Baformation Autherity
HNCRFW - National Commsission in the Role of Filiping Women
NEDA - Mationa) Economic Bevelopnieat Authority

NSCH « Nanonal Statistical Coordination Board

NS0 - Naticnal Statistics Office

NWRE - National Water Resource Burezu

NWRC - Naticnpal Water Resource Council

OP - Office of (he President

FCSD - Philippine Counsed for Sustainable Develapinent

PIC- Peoject hinplementation Consultants

PPEO - Provincial Planning and Development Office

PROWWESS - Pronsotion of ¢he Ro'e of Wosmen in Water,
Enviroumental and Sanitation Sources

SiD, \ Swedish Intentational Deve lopmenl Cooperation Agency

UM - United Mations

UNIFEC - United Nations Intesnationat Childeen®s Fund

UNDP - United Nations Bev clopment Project

ue- Um»cmty ol’l!ne Thilippines

WATSAN - Water and Sanitation

WhH - World Bank

WHO - World 1Health Organization

WECC- WG/ - Water Supply & Sanitation Collzborative
Council-Working Group on Urbanization

G - Globat ‘

- Central Governwent Level

R~ Regional Goveriment Level

£ - Provinciat tavel

M - Municipal Level

B - Barangay Lewel
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Annex | User’s Guide for Computer-Alded Planning

1. INTRODUCTION
The PW4SP Data Management User's Guide explains the procedure of encoding data and generating

tables and figures for the PWASP. The Guide consists of the following sections.

Section 2: hardwarc and sofllware required to succcssl‘ully run the PW4SP Data
Management System

Section 3: the concept of the microcbmputer archilecture and an overview of hardware
conﬁgurations

. Section 4; fundamentals to Opcrate the system with internal aruhllecmre
. Section 5: basic concept of soflware operahon

. Section 6: a complete list of data files and worksheets in the PW4SP Data Management
System

) Section 7: data linkages

e Section §: the procedure of updating the PWASP

. Section 9: standard report format

2. SYSTEM REQUIREM ENTS

The foltowing are the basic requirements to successfully run the PW4SP data management.

Hardware: . Softwave:

Computer: Pentium Series Qperating System: Window 95/98
RAM: 32 MB (minimum) © Windows Package:  MS-Office 97
Hard Disk: 3 GB (mini_nium) Spreédshcet_: ' MS-Excel 97
Floppy Drive: 3.5 inch .H.igh Density | - Word Processing: MS-Word 97
Monildr: VGA Momtor

Printer: 80 column (Can handle A4 size papcr)

Mouse: Any brand that supported by MS-Windows

Miscellancous: 500 watts Automatic Voltage

Regutator and Surge Protector
UPS 450 walts



LN MICROCOMPUTER SYSTEM

All computers, whether large or sinall, basically operate on the same fundamental principles. ‘Fhe
hardware and soflware of a mainframe computer and a microcomputer have the samc components

and fulfill the basic functions necessary to any compuler system.

The computer is seen as a powerful tool that can enable us to expand the horizons of our knowledge.
It allows processing of large volume of data or complex pattern of information that would otheirwise

be difficult to organize and understand. Morcover, it allows for an easy maniputation of data.

There are two major components of a microcomputer: the hardware and the soflware. These two

components complement each other in order to fulfill their basic function.

A microcomputtér hardware is made up of several components based on the functions they perform in

the system and how Lhey interact with the other components,
‘The principal efements of a computer systein are:

Central Processing Unit (CPU)

Main Mcmory (RAM)

Secondary Storage Devices (disk, drives, magnetic tapes, ¢le.)
Input/Cutput Devices {inonifors, printers, eic.)

o & & &

The CPU docs the actual computing. Tt is capable of simple arithmetic and ldgica'. op:c!rations', suchas
addition and dala'comp'arison, that are cxécuted ai Ekccedingi} high speed. ‘The poivcr ofa computer
directly stems from the speed and 3cc'ur'acy"\\‘filh.which the CPU can J:ény'olj{ computations and move ‘
nfﬂrmauon arouud The main memory of the computcr is usually referred to as Rnnn’om Access
Memory or RAM. “This part of the compulcr contams the progtams and m[‘ormat:on that are currently
being processed by the CPU. Se\,ondary storage dewce such as magnenc disk, is capablc of holding
large amount of data Proorams and data are normally stored on these sccondary dcv:ccs and could
be retrieved when needed. They are then loaded info the RAM and execuled The rpsulls of lhe
processmg can thcu be written into the secondary storage device or sent to an oulpul dewcc such as
the monitor or pnntf:r Peripheral devices or [nputhutput (UO) dewces allow the user to pul data into
a computer or receive output from a computer. A terminal is a peripheral that contains bolh a

.keyl.:loard for inpui and a monitor for oﬁtpul. Other peripherals include printeks and'ploltcré.



The diagram below presents the basic hardware component of a microcompuler system,

Central Pmccssmg Unit

(CPU)
[/O Tenminal ~ Sccondary Slqragc
| A
| . Random Access Memory
Keyboard (RAM)

. qp]| 1Hard Disk

Monitor  lgg—
- ST Floppy Prive

Printer <

Floppy Drive is the most common type secondary storége used in personal computer today. It acts as
an extemal drive from which the users ins‘.e.‘-.rl the ‘ﬂéppy disk Iblstorc and retrieve inf%)rinalion; The
ﬂbppy disk comes in tﬁrec siies* 3.5 iﬁches 5 25 inches and 8 in'ches It is characterized by 'thin
circutar plastic sheets coated with iron oxide so that magnet:c pattcms recorded on it can be retained.
The surface is smnlar to a magnetic tape used to ucord music. The 5.25 mchcs diskette is contamcd
in a square cardboard envelope in whtch it spms The 3.5 inches dlskette is contamed in a hard plastic

case with a metal shutter that protects the magnctic media. A ﬂoppy disk can store from 80 kilobytes

to 1.44 megabytes of data. l"loppy dlsk system is slowcr and has less storage capac:ty than hard d:sk -

system but its lower cost makcs ita popular choice for persona] computcr users,

Hard d:sk is made of magncm, metal, and can enher be removable or non—removablc The most

cominon type of hard disk that is found in personal compuler today is non-removable. This disk

typically holds from 10 megabytes to 3.2 glgabytes of information. Each megabyte is equivalent to

1,048,576 charactcrs of mformat:on or roughly 1,800 single-spaced typewritten pages; hence, this is

a very ef Ticient way to store largf: volume of information.

n\eyboam' is an exlemal device that acts as a pnmary interface bclween the human operator and the
compuler. The ke},'board has 3 basic componenls the typewntcr keyboard which i3 composed of
| alphabct characlers; the calculator pad which is composed of numeric characters; and the function

keys which scrve as special tacro key for various software.



LR

Monitor is the sercen or video display peripheral and serves as the main output device on a personal
computer. Tiis used to display text and graphics infoermation and is available in a varicty of sizes and
types. Monitors can be divided into two broad groups: those designed to display text information; and
thosc designed to display graphics information, such as charts or picture. Within the graphics group,
there are color or monochrome (single color) displays. A high quality graphic color monitor s

capable of showing high-resolution paltern and is recommended for applieation in MS-Window,
Excel, or AutoCAD,

Printer is another common pevipheral found in personal computer system. The common types of
printers are d.ot matrix, inkjet and laser printer. ‘The dot matrix printer pr;::nduccs its image by printing
a gmup' of dots that form the imaéc of a cﬁ'iracter or symbol. Thc inkict printcr is similar to the
|mpacl dot matrix printer, instcad of u‘:mg the pin impact force to create an mlagc it use ink bubble to
create smuhr unage The inkjet printer is much lighter and quict than the impact dot matrix printer.

Today, it is the popular choice due to it characteristic and wide availability of sclection. "The laser
printer produces its image by means of clectrophotograph simular to the principle of photocopy
machine. The image produced in the laser printer is much crispiér than the inkjet printer due the high-

resolution capability. Both the inkjet and laser printer can produce color print.
4. . OPFRATING SYSTEM

Operanng sysums is a st of control program lhat managcs the compuler s resources and creales a
well-defined soﬂware envnronment for computcr apphcatlons Computer hardware by itself can
perform little useful work. A computcr rcqunres softwarc to be able to communicate and do useful
work. The first layer of sofiware in a computer syslem is ihc 0peratmg system. This is what staris, or
boots up, the machine hclps in pulling |lself up by its own bootstraps and estabhshes a predetermmed
set of conditions so that apphcahons can be run. When the computer is turned-on or the resetl button
is pressed the control is pass to a set of control programs found in' the ROM, a ﬁrmware store in
computer ¢hips. These programs perform several tasks: (1) to check if hardware are functioning
correctly; (2) to toad a set of control program from the disk tob the memory; and (3) to pass control to

a routine which will accept the user input. At this point, the operating system is loaded and the user

can exccute an appﬁcation program such as MS-Word, Excel, Power Point, Access, elc.

 An operating system by itself has two levels of funciionality. “The first level is scen by the user

running the applications and utilizing system commands and ufilities. At this level, each operating
system has its own set of command used to accomplish frequently performed tasks 5uch as copying
ﬁles, renaming files, and formatting disks. Normally, frequently-used functions are included in the
operating system as system commands. The second is al the programming level.  All operating

systems contain a set of pre-packaged routine that performs the “primitive” funclions necessary in



almost all applications. Such {unctions, like sciding a character to the sereen, reading and waiting
information from a disk file, and accepting input from the keyboard are common to nearly all

programs. This level of funclionalily gives the programmer a set of standardized routines to perform
(his task.

5. SOFTWARE

The operating system alone renders the computer nearly wseless, unless the user is capable of directly
communicating to the hardware. In order to use the computer system, software is needed, Vavious
software are available for dilferent purposes, such as MS-Word for word pracessing, FExcel for

spreadsheet, Power Point for presentation, Access for database and Foxpro for database
programming. ' '

51, MS-WINDOWS

MS-Windows is the most popular opcmlmg syslem it duphcatcs all the function performed by DOS
the dcfuncl operating system of the seventies and eighties. The capablhty of MS-Window operatmg
system far excecds that DOS can offer it most convenieal and casy fo navigate. Most of the
commands are represented by dcbcnptwe figures catled icons. Navigating around the windows could
be achieved through the usc of a pomlmg device called mouse, normally in the desktop envlrnnment
the niouse pomtf.r is seen as outline of an arrow or white arrow To execute a command ‘the user
only need to bring the mouse pointer {0 the dcsnred command described by the icon and press the right
button or double click the fefl button The execunon starts thhout typing any single character in the |
keyboard, unlike the DOS conventlon that needs typing a senes of characters comprising the
command. In wmdows the compuler screen is referred to as the deskmp When working, the
application and documents must be in thc windows. The windows on the desktop must also be
arranged. Ifan application is lefl for a whlle, the windows are shrunk to an applicatien icon, and still, |
the applkatidn keeps running on the background. When an application is shrunk, the windows place

their applicaﬁon icon at the bottom edge of the desktop until it is again restored to window size.

With windows, 's_c\-'eral powerful applications can be run simultaneously. For examnple, switching
from a word processing aﬁplication to a spreadsheet, and then to database application with a few
simpte moves while quitting one application and restarting another, can easily be done.

Parts of a Windows

Fach application and some documents the user choose o work on, open as separate windows. Every

window has somie common elements, however, not all windows use all the items.




The elements as illustrated below are the tools for working with the window and the application or

document within the window,

wErAae

Control-menu Minimiza

bufron

: [y Maximize

Elle Edit Search  Help button

I- — A - Insertion
~y point

1 § Mouse

21 pointer
L4 Window
21 border
' Verlical
24 scrolf bar
¥

-Wmdowcorner | Honzonta! scrolf bar A

The Con!ml—menu bax located in the upper-lefl comer of the window is the most useful menu when
the use of a keyboard is preferred The Control-menu commands can resize, move, maximize,

; minimize and close windows, and sw1tch lo Task Llst

The title bar shows the name of the application or decument. If more than one window is open, the

title bar of the active window has a different eolor or intensity compared to the other title bars.

The window title, depending on the type of window it appears, can be the name of an application and

the name of the document, or a placcholder. In such case, “untitled” nonnally. appears.

The menu bar tists the available menus. Most a'pplications have a File menu, an Edit menu, and a

Help menu as well as other menus uniﬁ[uc to the application,

The Scroil bar can move the parts of the document into view when the entire document will not fit in

the window. With the bar, unseen portion of the lsts and other information that is too Iong to ﬁt in

the allotted space can also be viewed.

. The Maximize and Minimize buttons enlarge the active application window to fill the entire desktop or

shrink the window 1o an icon. Document windows enlarge just to fill the application workspace and



not the eatire desktop. Afler enlarging the window, the Maximize buiton changes to a Restore bulton,

Restore button can be used to retwn the window to its previous size.

The Window border is the outside edge of a window. It can lengthen or shovten each side of the
border,

The Window corner can be used to shorten or lengthen two sides of a border at the same time.

The Workspace is where most of the work with an application are done.  For example, the content of
the documents appears in the workspace when starting a wordprocessor. Hence, an application can

allow the opening of more than one document window within this workspace.

The selection cursor shows where the user is in an individual document. It marks the place in the text
or graph:cs where the user begins typing or drawing. The arrow- shapc HI0USE pomlcr appears if you

have a mouse installed, It is used lo indicate items the user wants to select with mouse.
Starting Applications with the Run Command

The Run connnand is a handy way to st_art‘applications that you want to run only océasionally or have

not yet added to a group. You can open a document at the same time you start the application.

Unless the program file is in your current path, jro:_x n'iced to know the exacl directory location and

narme of the program file before }’6u.can start the application.

1. Choose Run from the File menu in Program Managcr or Fllﬁ Managcr
" The Run dialog box appears.

2. Type the pathname and the exacl fi lename of the program file, mcludmg the extcnmon

1f there is one.

3. Hyouwantthe apphcation to Shl ink to an icon as soon as it starts make sure the Run
Minimized check box contain an X.
4. Choose OK or press ENTER.

5.2. MS-EXCEL

Excél is a spreadsheet type of | soflware package that operateé under the MS-WINDOWS operating
system. The primary documeni in Excel is called a workbook The workbook is similar to a ledger
that stores infohnétion'and each workbook is made up of sheers. The sheet is virtually divided into
column and row; the column run horizontally and denoted by an alphabet starting with 4 and the row

un verlically and denoted by number starting from 1. The intersection of column and row is called
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rell. The cell is the basic component of workshect that accept different data types. The most

common data {ypes are character, number, dale, logical value and formula.

Standard Toolbar

The standard toolbar that normally appears at the top of screen helps select options. Such options can
open workbook, print and save worksheet, and ask for help. The following is a list of the individual

icons and their respective functions.

Excel’s Standard Toolbar

Butten Name : Function
D ‘ New Workboek Creates a new workbook
L
Open Opens a document
' E’ , Save Saves the aclive workbook
I % ' Print Prints the active workbook
B‘ Print Preview Shows the active document in print preview mode
AP W o :
V’J Speller - Checks the spelling of the document
33 | cut Cuts the selection to the Clipboard
Copy ' Copies the selection to the Clipboard
‘ﬁ Paste Places the Clipboard contents at the insertion point
o




Buiton

Name

Fl_q n}t*_@_ion

kd

Format Painter

Copics and pastes foimals for cells and objects

X Undo Undoes the Jast action or command
4 Repeat Repeals the last action or command;
e this is the same as the redo feature in Word 6
h AutoSum Inserts the SUM function and shows sum range
f\:’ Function Wizard Starts the Function Wizard
% l Sort Ascending Sorts selected rows in ascending order
Z : L -
A Sort Descending Sorts selected rows in descending order

_:g ChattWizard Activates the ChartWizard

Téxt Box | lnserts tc'xt or text box

E Drawing Tums: the drfa.wling toolbar Qp or off .
—E Zoom Control Sels ihe view of the docurnent

|@ . | T\p Wizard Tums the TipWizard toolbar on or off




»

Button | Name | . Fumetion
Help Nisplays Help
-l :;:——ialh—_ E Fomt Scts the font for the selection
” E Font Size Scts the fonl size for the selection
E Bold Boldfaces the sele;lion
Z Italic [talicizes the selection -
E Underline Underlines the selection
: % Align Left Leﬁ-al.igns the selection
_é | Center Centers the selection -

Align Right

Right-aligns the selection

)

l‘g{_j g;?;::\:;c ross chtérs the sclec.lien across cotumns
E Clun';:n‘.;y Style Change; the selected cells to defauli cuneﬁcy style
E;’;;’ Percent Style Changes the selected cells to de faulf percent style |
[ Comnia Style Changes the selected cells to default comma style




| twttoen po hame ] Function
.0 . .
D0 Increase Decimal Adds one decimal place (o the number format
'*.Q:g Deerease Decimal Removes one decimal place from the number format
feord
SN I 4 Borders

Enables you to select a border for the selection

x Color

Sets the color for fhe seleclion

ﬂ Fout Color Sets the color for tﬁe selected font




Basic Part of Fxcel Screen
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Tabs

Worksheet

MS-Excel Basic Operation

- Followmg the description oflhe basrc operatlon lhc mouse is used as a pomtmg device instead of a
keyboard. The word click means the user must press the lefl button of the mouse; double click means
two successive clicks; and enter means the user must press the Enlcr key in the keyboard. Basic

operation dealt only {0 the routine .ne'cessar):r to update the PW4SP data base.

C}eating a New Worksheet

When you enter Excel, it opens up to a new workbook, by default it contain 16 worksheets. You can
use any of the worksheets. LEven if there is an opén workbook, you can still open another by moving

the mouse pointer in the New icon (upper Icft of the screen below the menu bar). Clickon it

Saving the Weorkbook

1. Move mouse pofnter to File menu and click on it to bring the File menu option.
2. From the oplion available. Select Save.
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If the document your saving is new. The Save As dialog box appear. In the File Name box
typc the name of the workbook.

Enter Datain a Cel}

1.

2.
3.

First sclect the cell by moving the mouse pointer and clicking the right button. (L

“Fhis rouline place the insertion point in the active cell, wInch is highlighted on-screen with
border around it

You can start entering the data from your keyboard or numeric keypad.

To confirm the mpul you can press ENTER or move the mouse pointer to the Formula bar
and click the Check icon,

Editing Cell Co ntents

1.

W o

Double-click the cell containing the dala you want to edit. To cdu in thc formula bar, click
in the formula bar., In case the formula bar is not displaycd, choose Formula Bar from the
View menu localed at the top row of scicen.

Bdit the celi contents. .

To confirm the modification made in the cell, click the Check icon in the formula bar or
press ENTIR. To cancel edits, click the )L icon In the formula bar or press ESC,

(‘Icanng Celis

1. Sclect a cell or range of cells that you want to clear.

2. From the Edit menu, choose Clear, and from the option avallablu
you the choose All, Contents, Formats, or Notes
Shortcut : Press DEL., ,

To clear cells by dragging ‘ ' | (

1. Select a cell or range of cells that you want to clear.

2. Move the mouse pointer in the filf handle (fower right comer),
drag the {ill handle toward the area of cell or range, then the selected
area will become gray.

3. Rclease the mouse bufton.

Copying Cblls

1. Sclect the cells contamlng the data you want to copy

2. From the Edil menu, choose Copy. .

3. Select the upper-left cel! of the paste area.

Beware that any values or formula in the paste area will be replaced.

Undo Cqmmand

To undo your last command, click the Undo button.
From the Edit menu, choose Undo.

Crealing Border around Cell

1. Choose the Cell menu from Format menu. ‘
2. Choose the side you want put the border, and then choose type of border. a
3. Click OK button. i
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Deleting Rows and Columns

1. Select the row or column _
To delete more than one row or column, extend the selection to include
all the rows or columns you want to delete.

2. From the Edit menu, choose delete (Entire rows or column)

3. Chick OK button

Inserting Rows and Colunins

1. Seclect the row or column _ '
To insert more than one row or column, cxtend the selection to include
the number of rows or colunmns you want o insert.

2. From the Edit meny, choose Inscrl (Entire rows or calumn)

3. Click OK button.

Selecting a Sheet or Sheets
To select a single sheet, click the sheet tab.
To select two or more sheets

1. Click the sheet tab for the first sheet you want to select.

2. If the sheets you want to select are adjacent, hold down the SHIFT key
and click the tab for the fast sheet.
If the sheets you want to select are non-adjacent, hold down thc CTRL key
and click the other sheet tabs.

Ungroup Selected Sheets

1. Move the mouse pbinlcr to the shect tab. Click the left button of the mouse.
2. While the mouse pointer still on the sheet tab, click the right bulton and
choose the Ungroup Sheets. B

Inserting Worksheet

1. Select a sheet or sheels in the workbook.
From the Insert menu, choose Worksheet.
The new sheet or sheets will be msertcd to the left of the sheel tab you select.
Shortcm SHIFT+T11 '

Deleting Worksheet

1. Selm.t a sheet or sheels in the w orkbook
2. Move the mouse poinler to the sheet tab, and click the nght button.
3. Choose Delete, and click the OK bulten. '

Moving Worksheet Within the Workbook

1. Select the sheet or sheets you want lo move.

2. Drag the selected sheet tab along the row of tabs.
A black triangle indicates the place where the sheets will be inserted.
All selected sheets will be inserted.

3. Release the mouse bution.



Alteinate Mcethod

1
2
3.
4

Select the sheet or sheets you want to move.
From the Edit menu, choose Move or Copy Sheet.

In the Before Sheet box, sclect where you want sheets to be inseited.
Click the OK butlon. Q’x:\‘r-

Moving Sheets to Other Workbook

1. Open the workbooks you want to move sheels fo and from.
2. Sclect the sheet or sheets you want to move.
3. From the Edit menu, choose Move or Copy Sheet.
4. Inthe To Book box, select the destination workbook, _
5. Inthe Before Sheet box, select where you want the sheet or sheets inserted.
6. Click OK button.
Alternative Method
1. Open the workbooks you want to move sheets to and from.
2. From Window menu, choose Arrange and choose horizontal.
In the desktop, two workbooks will open in screen split the workarea hor:zonta!ly
3. Select the sheet or sheets you want to move. .
4. Hold- down the CTRL key and the right button of the mousc.
A paper icon and black triangle indicate that you made the move routine active.
5. Drag the mouse pointer to the other workbook and select where you want
the sheet or sheets inserted.
6. Release the mouse button,
Copying sheets within a workbook ' S : %
1. Selectihe sheet or sheets you want to copy.- : '
2. Hold down the CTRL kcy and mouse feft buiton, and then drag thc selected
shect tab along the row of abs. A black triangle indicates the p!ace where
the copied sheet will be inserted.
3. Release the mouse button and then the key.

Alternative Meth.od.

hallPalbalis dh

Select the sheet or sheets you want to copy. :

From the edit menu, choose Move or Copy Sheet.

In the Before Sheet box, sclect where you want the copied sheet inserted.
Select the Create A Copy check box.

Click the OK button.

Cop)ing sheets to other \mrkbook

?‘“‘F‘F"PP‘!"?"‘

Opm the workbook you want to copy (o and from.

‘Select the sheet or sheets you want to copy.

From the Edit menu, choose Move Or Copy Sheet.

In the To Book box, select the destination workbook.

{n the Before Sheet box, select where you want the copicd sheet inseried.

Select the Create A Copy check box. a
Choose the OK Butlon.
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Printing your Work

1. From File menu, choose Page Setup to display the Page Sctup dialog box,
2. On Page Sctup dialog box, their are four option available

Page tab controls page oricntation, scaling, page size, print quality, and
starting page number for the selected sheet.

Margin tab controls page margins and the header and footer margins, and
cenler the shect on the page vertically, horizontally or both.

Header/lFooter tab controls page the headers and footers for the selected sheet.
licaders and footers arc descriptive text that print at the top and bottom of
¢very page in your sheet. You can add, delete, edit, format, and posilion
headers and footers, and view them as they will print,

Sheet tab spccifics which areas of the sheet you want to print, and controls
the print titles, page order, and draft quality. Also controls whether
gridlines, cell notes, and row and colunwn heading print. The Shect tab is
displaycd if the active sheet is a worksheet or macro sheet,

3. On the Print What, their are three option avaitable,

Selection oplion prints'only the sclected cells in the selected sheets,
Nonadjacent sclections arc prmted on scparalc pages. Sclcelmg this
ovetrides any prmt areas you have dcﬁncd for the selected sheets using
Print Area option on the Sheet tab of the Page Setup dialog box.

Selected Sheets oplion prints the arca of each of the currently selected sheets,
with each print area starting on a different page. lfno print area is defined
on a separate sheet, the entire sheet is printed.

Fmrre Workbook option prints the entire print area of all sheets in the aclive
workbook. If a shieet docs not have a print area, that entire sheet is printed.

4. On the Copies box; ‘specifies the number of copies to print.
‘5. On the Page Range, their arc two option avatlable.

Al option print all lhc pages in the sclected shee{s ‘

Page(s) oplion prml the range of pages specified in the From and To boxes.
Page numbers you selected in the From and To boxes aftect which cells
will be printed, not the numbering of the pages upon which they are
printed. To change the numbering of printed pages, specify a number in

. the First Page Number box of the Page tab in the Page Sctup dialog box.
6 The user have option to see the appearance of the pnnt by clicking the
- Print Preview button.
7. Printer Setup option gwc the user an option to select among the available
 printer drivers.
8. Click the OK button to procecd prmtmg

53 M S-\VORD

MS-Word is word probcssmg type of software. ‘This is analogous of converting your computer 1nm
typewriter machine. You have page in which you lypc characlers you have a mler that show where
you are as you fype across the page. You have labq stops and margin settings. Ihc inseriion point

moving across the page even acts like the print head moving across the page.

MS-Word offer more advance features that you need to create from simple to complex type of

document. When you start Word you will notice almost the identical appearance with that of MS-



I’xcel. Most of the command are represented in terms of icon, in the middie of the workspace were

you ¢nter your text and other object included in your documents.

Starting Word

From the MS-Window enviroimment, yoﬁ can double-click fhe MS-Word icon in the MS-Office
program group. In some case thc MS-Office administrator is automatwally loaded at start-up of
Windows eavironment. The MS- Ofilce administrator menu icons are located in the upper right side
of the screen. You can start MS-Weord by clicking the icon.

Quiting Werd

1. Move mouse pointer to File menu and click. File sub-menu will appear.

2. From the File sub-menu, move mouse pointer to Exit option and click.
The MS-Word environment will normally terminate. In some cases, if some active
documents has not yet been save, MS-Word give the user’s option 1o save the documents.

Standard 'I‘oolbar

The standard toolbar which normally shown at the top of screen helps you select the option, from
this tootbar. The user’s can open new docu'ment' open existing document, print and save docurhent
and ask help to farther understand some functlon or pmccdure to accomplish desired task, Usmg the

toolbar speed-up the desire task instead of using lhe menu (located at the top of the serecn). The

following shows the list of standard toelbar icons and their function,

- MS Word Standard Toolbar

existing file to open

Buften Name " Function
D New Creates a new file based on the Normal template
d-v‘ B '
@ Open Displays the Open dialog box so that you can selecl an

' Save Saves the current document

Print Prints the current document

_@_@

Print Preview Activates Word’s print preview features




Rulton

| Name 7 "~ Function S
RECs . . .
J Spelling Initiates a spelling check
.}E Cut Cuts selected material to the Windows Clipboard
Copy Copies selected material to the Clipboard
@ Paste Pastes material fi rom the Clipboasd into your document
‘@ '| Format Painter

Copies the formatting of a selection to the text you specify

Ky Undo

Undoes the commands you select (rom the list presented

ol Redo Redocs the commands you select from the list presented
' E AutoFormat

Formats your document automatically

Insert Auto Text

Inserts an Auto Text entry,
Insest Table Inserts a table into your decument ‘ _
@ Insert Excel B Inserts an Excel worksheet into your document
Worksheet
== :
== Columns Formats your document using columns
@ Drawing Opens the drawing application and enables you to draw a
picture in your document
@ Insert Chari

Inserts a chart into your document
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Zoom Contol

Name

I‘unchon

Scales your view of the document by the percentage you
select ‘

Help

Activates context-sensitive help

MS-Word Basic Operation

Opening and Existing Document

1. Ctick the Open Folder icon (normally second from the left) to bring up the open

dialog box.

2. Inthe Open Dialog box, select the fite you to open from File Name combmahon

box.

3. Click the OK button.

Changing the Format of the Text

1. Click the arrow buiton to the right of the fon! box to bring the list of available font.
2. Scroll through the list box by clicking on the scroll bar, and select a font by chckmg

on it,

3. Begin typing. The text will appcar in the font you just selectcd

Changmg the Font Size

l. Click the arrow buiton to the right of the font size box to bring the list of available size.
2. Scroll through the list box by clicking an the scroll bar, and select a size by clicking on it.
3. Begm type. The text will appear in the font size you size selected. :

Choose a Style

Perform any of the following procedures to change a font style:

« Click on ihe button labeled B to set the beld feature on.
You also can press Ctrl+B from the keyboard. .

* Click on the buiton labeled I to set the italic feature on,
You also can press Ctrl+] from the keyboard.

» Click on the button fabeled U to set the underlined featurc on.
You also can press Ctel+U from the keyboard.

* Click on the button labeled B and I to set both bold and italic features
You also can press Ctrl+B followed by Cul+I from the keyboard.

Setting Special Effects

You can use a variely of special text effects:
& Strikethrough
+ Superscript
e Subscript




¢ [Tidden
¢ Swall caps
¢ Alicaps

To set any of these features, use the following procedure:

1. Open the Format menu and sclect the Font atem.

2. If the Fonts tab is not on top, click on it.

3. In the Effect group box, sclect the check box that represent the special effect
you want to turnon,

4. Click the OK button.

5. Begin typing. Your text appears wuh the special ef fccl you sclected.

Setting the Indentation

—

-

Open the Fermat menu and select the Paragraph item,

If the Indents and spacing tab is not on top. click on it.

In the indentation group box, use the Left and Right spin boxes to set thc mclcntalmn

from the left and nght margins. Click on the amow buftens until the measurement is correct,
or sclect the text in the body by hlghhgh(mg it w:th the mouse and then type cxact
measurcment you want.

To set first line or hanging indeiitation, open the Speciai drop down list box by

clicking on its arrow, and select the appropriate item. Use the By spin box to set the
measurement for the first line indentation or the hanging indentation.

Click the OX button. Your current paragiaph takes on the indentation you just set.

Each subsequcnt paragraph you create takt,s on this patiern, nnlcss you resct the

indentation usmg the dialog box

Setting Line Spacing

Open the Format mien and select the Paragraph item.

§f the Indents and Spacing tab is not on top, click on it.

In the Spacing group box, use the Before and After spin boxes to set the distance in

points froem the previeus paragraph and from the following paragraph. Click en the arrow
buttons until the measurement is correct, or select the text in the box by hxghhghlmg, it with

- the mouse and then type the exacl measurement you want,

To set line spacmg within the paragraph, open the Line Spacing drop -down list box by
clicking on its arrow, and select the appropriate ifem. Then use the At spin box to set the
measurement for number of lines or distance belween lines, whichever is active.

"Click the OK button. Your current paragraph takes on the line spacing you just set.

Each subsequent paragraph you create takes on this pattern, unless )ou fescl the tine spacing
using the dialog box. :

Copying and Inserting Text

1. Highlight the text by dragging the mouse pointer over the text to be seiected
2. Move pointer to Copy icon and click on it.
3. Move mouse pointer to the place were you would like the insertion take place
4. Move mouse pointer to Paste icon and click on it. Altematively, you can press the right
button of the mouse to bring the menu option., select the paste by click on it.
; Undoing and Redoing

If you do make a mistake, you ean undo it by selecting the Undo option from the Edit menu.



This procedure undoes the last change you made (o the decument. Word always will add the name of
the operation you are aboul to undo as the sccond word of the Undo menu item. If you cannot undo

anylthing, this option change to Can’t Undo and is dimmed.

Overstriking Text

There are times, however, when you wanl to ype ever existing text. To swnch i this cdltmg mode,
press the Insert key in the keyboard. When you type, the characters you type rcplace any characlers

to the left of the insertion point. To tum off the overstrike mode, press the Insert key again,
Deteting Text

Use mouse pointer (o highlight the desire text and press the Del key from the kéyboard.

Insert File

l. Mou, mouse pomler in thc locauon were you would hkc the msemon take p!acc
2. From the Insert menu, select File option.

3. From the File name combination box, select the ﬁlc you would hkc to insert.
Click the OK button,

Creating the Header or Footer

1. From the Vlew menu, choosc lleader and Footer. .
2. The Header and Footer toolbar appear, click the switch bctwecn Header

and Feoter button. The header and footer areas are enclosed by a nonprinting @
dashed line. : '

3. Do one or more of the followmg,
Text - You can type the text w1thm the dashcd line that surround the header or footer area.
Page Number - Click the icon.
Current Date - Click the icon.
Current Time - Click the icon.

4. To rcturn to the document, choose the Closc button on the Header and Footer toolbar or
double-click the mam text area

Prcvicmng the Document

I. From the F lle menu choose Prmt Prcv:ew
While in the print prev:ew mode, you can perform the following options.

a) You can print the docu_menl by click the Print button.

b) You can switch the magnifier on and off by clicking on the magnifier button.

¢) You can switch to a one page view by clicking the One Page button.

d) You ¢an swilch to view multiple pages by clicking on the Multipie
Pages Button and dragging across the grid that appears, releasing the
mouse button when you have the multiple-page view you want to use,

€) You can zoom in or out on your document by adjusting the zoom
percentage in the Zoom Control drop-down list box.

f) You can switch the view of the ruler on and off by clicking on the
View Ruter button.

2) You can squeeze a small amount of text on the final page into the g
the outer pages by clicking on the Shrink to Fit button.



1) You can expand the preview screcn to show only the page, the
toolbar, and the status bar clicking on the Full Screen button.
i) You can exit the preview mode by clicking on the Close button.

Frinting your Document

1. From the File menuw, choose Print oplion.
A Print dialog box appear.

2. In the Print What drop-dowa list box. This ophon enables you to print the
document or several items ancillary to the document, such as Summary Info,
Annotation, Style, Autofext Entrics, and Key Assignments.

3. Usc the Copies box to enter the number of copies to print.

4. Usc the Page Range option to determine how much of (he document o print.
You can print All the document, the Current Page, or selected Pages.

5. Cheek the Collate Copies check box to finish lhe ﬁm sct of copy before
printing the second copy.

6. \When all it set correctly, close all the dialog boxes you have open,
and click OK button, the printing process begin.

0. PW4SP DATA FILES

Data files are collection of information relevanl lo the preparauon of PW4SP. Data files are logically
group into threc major areas of mformauon The first group of 1nformat1on are the base data that are
composed of information dcnvcd from : survey, ocular inspection, and existing information from the
provincial and national agencif:é The second group of information are the key parameter dala thatare
composed of information derived from apphcablc policies, assumphon water fest result, and current
cost of commodity. The third group of mformatlon are the prcsentatlon of data whlch derived from
the previously mentioned groups of information’ s, this data are processrd and then logxcaily arranged
to show provmﬂlal profile, existing facilities and service coverage, past financial performance fulure

requ;rement of the rclevant sector, cost estimates for future scctor deve!opmem and financial

ammangement.

6.1. Base Information

1. Socm—econom:c Da!a (Socm £CONOMIG. xls)

a) Mumcapala’Clty Slatus and No. of Barangays ( Muncny Status (P 1.1))
b) Past Population ( Past Population (P.1.2.1) & (P.1.2.2) }

¢) Projected Population ( Projected Population (P.L.3.1) & (P.1.3. 2) )

d) Household ( Houschold) (r.1.4))

¢} Services ( Services (P.1.5))

f) Occupation ( Occupation (¥.1.6) )

g) Family Income ( Family Income (P.1. )

h) Expenditure ( Expenditure (P.1.8) )

i) Education { Education (P.1.9))

2. Land Use Data (Landuse.xls)
a) Existing Land Use { Existing Land Use (P.1.2.1))



6.2,

6.3,

b}

Future Land Use ( Future Land Use (P.2.2) )

3. Health Data (Hcalth.x1s)

a)
b}
c)

Morbidity, Mortality and Infant Mortality ( Morbidity and Mortality (1.3.1))
Facitity { Facility (P.3.2) )
Practitioner ( Practitioner (".2.2) }

4, Water Reso:ﬁc_é Data (Water Source,xls)

a)
b)

General Information { Gen. Info (r4.1))
Water Source Information ( Source Into (P.4.2))

5. IWater Supply SyslémS Data (Wétc'r Sﬁpply.xls)

a)
b)

c)

Levell Famhty([cve’r Ipsn) .
Level H System { Level 11(8.5.2.1) &£ (5.5.2.2))
Level HI System { Level I (S.5.3.1), (8.5.3.2), (8.5.3. 3)&(8534))

6. Environmental Sanitation Data (Sanitation.xls)

a)
b)
<)
<)
f

Houschold Toitets { Houschold Toilets (P.6.1) )

Schoo! & Student ( School&Student (P.6.2) )

School Toﬂct (Schonl Toilet (£.6.3) )

Public Toilet ( Public Toilet (P.6.4. 1}, (P.6. 42) & {(P.6.43))
Drainage Facility { Drainage Facility (P.6.5) )

Solid Waste Collection and Disposal ( (M) Solid Waste)

7. Investment Data (ln'vestme:m.xls) o ‘ ' é)

b)
c)
d)
c)
f)
g)
h)
i)

. Income & Expenditure (P.7. l)

Past IRA (P.7.2) -

Available Funds for Caplta] Txpendtturc (P 1.3)
Scctor Previous Investment (P.7.4)

Sector Allocation in the AIP (P.7.5)

Allocation of the 20% Dev. Fund (P.7.6)

Financial Indicator of WD {P.7.7)

1.oan Status of WD (P.7.8)

Affordability in Water & Sanitation Services (P.7.9)

Key Parameter

l. Key Pammelers (Key Parameter xls)

a) Key Paramcter {Key Parameter)

b) Level I - Safe and Unsafe (Level I Safe and Unsafe)
¢) Well Source Composition (Well Source Composition)
d) Unit Cost {Umnit Cost)

¢) Scoring Factor (Scoring Factor)

f) Annual Investment (Annual Investment)

Data Presentation ' . g

L. Provincial Proﬁ!e (chapter-3 xls)



a) Outline of City and Municipalitics (MTable 3.1.1)
b) Current Land Use (MTable 3.2.1)
¢) Drainage Arcas and Flow Rates of Major Rivers (MTable 3.2.2)
d) Distribution of Itouseholds by lncome Class (MFigure 3.3.1)
¢} Population Distribution by Occupation (Figuse 3.3.2)
1) Population Distribution by Highest Attainment of Fducation {M%igure 3.3.3)
g) Provincial Qutline on Public Services (MTable 3.3.1)
h) Public Facilitics and Services by Municipalily (MTable 3.3.2)
i) Previous Population l)cvclopment of the Province (MFigure 3.4.1)
1) Previous Population Development by Mumcspahly (MTable 3.4.1)
k} Present Population Distribulion (thurn 3.4.2) .
1} Outline of Urban and Ruial Areas in the Province (MTable 3.4.2)
m) Houschold Numbers and Houschold Sizes {MTablc 3.4.3)
n) Number and Rates of Ten Leading Causes of Morbidity,
Mortality and Infant Mortality (MTable 3.5.1)
o} Reported Cases and Deaths of Notifiable Water Related Dascases {MTable 3.5.2)
p) Municipal Solid Waste Collection and Disposal, and
Service Coverage in 1994 (MTable 3.6.1) -
q) Number and Ratio of Population to Health Facilitics
and/or Medicat Praclitioners (STable 3.5.1)
1) Types of Drainage Facilitics {STable 3.6.1)
) DENR Water Quality Criteria/Water Usage and Classnﬁcallon
for Frosh Water (STable 3.6. 2)

2. Existing Facilities and S‘erwce Cmerage (chapter-4 xls)

a) lnformallon on Exaslmg Level 1l Sysu.ms (MTabIe 4.1 2)
b} Information on Water District (MTable 4.1 3) -
¢) Information on Existing Level 11 Systems (MTable 4.1 4)
d) Information on Existing Level I Facilitics (MTable 4.1.5) ,
) Water Supply Service Covcragc by Municipality in 1994 (MTable 4. ! 7)
f) Water Supply Service Coverage by Municipality (MFigure 4.1.1)
g) Sanitation Facililics and Service of Household 'I‘o1lels Urban and
Rural, 1994 (MTablc 4.2.1) - .
h) Provincial Service Coverage of Household Torlel Fac:lltlcs l994 (Ml"]gurc 4.2.1)
i) School Toilet Facilities and Service Coverage in 1994 (MTablc 4.2.2)
i) Public Toilet Facilities and Service Coveragc in 1994 (M'l‘able 4.2.3)
k) Details on Existing Level MI Systems (STab]e 4.1.1 Sheet 1 to 4)
1} Details on Existing Level 11 System (STable 4.1.2 Sheet 1 to 6)
m) Number of Level 1 Facitities by Safe and Unsafe Classification (STablc 4.1.4)
n) Estimation of Unserved Population by Municipality {STable 4.1.5)
o) Estimation of Population Covered by Safe and Unsafe Source
by Municipality (STable 4.1.6 Sheet 1 10 2)
p) Sauitation Facitities and Service Coverage of Household Toilets
by Type, by Municipality, Urban and Rural, 1994 (STable 4.2.1)

3) Past Financial Performance in Water Supply and Sanitation (chapter-6.xls) '

a) Actual Income and Expenditures, (MTable 6.2.1)
b} Intemal Revenue Allotment to the Province (MTable 6.2.2)
¢} Allotted Funds for Capitat Expenditures {20% DF) {MTable 6.2.3)

d) Actual Amount of Sector Investment to the Province by Concerned Agencies

(MTable 6.3.1)
¢) Annusl Investment Plan 1995 1599 (MTable 6.3. 2)
f) Sector Allocation in the Annual Investment Plan (MTable 6.3.3)



g) Allocation of the 20% Developmient Fund (MTable 6.3.4)

h) Tinancial Indicators of l’rovnncnIfMumc:pal Watenvmks in the
Province (MTablc6.4.1)- ,

i) Loan Statusof ¥’s ovmclalmftmmpal Watcrwoxks {MTablc 6 4.2)

i} Affordability in Water Supply and Sanitation Servwes {Mtable 6.0.1) (

k) Income and Expenditure (STable 6.2.1) : e

) Past haternal Revenue Allotment for the Province (S l'able 6.2.2)

4) Water Sornce De»e!opment (c‘haptcr-? xls)

a) l*xistmg Grounclwalcr Sources in the Province {MTable 7.1. l)
b) Work Flow of Groundwater Avaitability Map (SFigure 7.3.1)
¢) Exisling Sprmg Sources by Municipality (STable 7.4.1)

d} River Information and Related Data {STable 7.5.1)

¢) Water Qualily Analysis Results (STable 7.5.2) ¢

£} Existing Well Sources (STable 7.0.1)

g) Standard Spec:ﬁcanon of Wells by Mumcupahty 31 ab!c 7.6. 2)

5) Fuiure Requirement in Water Shpp{v and S'am!armn Enwromnenr (chapter-S xls)

1) Provincial Sector Targels (M I able 8. 2 1) . '
2) Basc Year Service Coverage of Water Supply (MTable 8. 2 2)
3) Base Year Service Coverage of Household Toilets (MTable 8.2.3)
4) Base Year Service Coverage of Public School To:lcts and
Public Toilets (MTable 8.2.4) - o
5) Base Year Service Coverage of Mumcapal Solid Waste System in 1994
(MTable 825) - .. :
6) Regional Population Pro_iecl (M"l abIe 8. 3 ]) e : - é :
7) Municipal/City Population Projection (MTable 8.3.2) .
8) Municipal/City Population for the Year 2010 & Growth Rates (MTabIe 8 313
9) Past and Projected Populahon by Cuitent Municipality/City (MTable 8.3.4)
10) Past and Projected Population by Urban and Rural Area of Cumrent
Municipality/City (MTable 8.3.5) . :
11) Prajected Public School Enrallment and Numbe;r of Public Utility
by Mumc:pahty {MT: able 83.0)
12) Population to be Served b) Target Year (Watcr Supply) (MTable 8.5. l)
13) Additional Numbér of Households tobe Scrved by Target Year
{Housechold Toalets) (MTable 8.5.2) o
14) Additional Number of Public School Student to be Served by
Target Year (Schoo] Toilets) (MTable 8.5. 3) ‘
15) Additional Number of Public Utitities with Samlary Toilets
by Target Year (MTable 8.5.4)
16) Populatien to be Served by Urban Sewerage in Phase 1l (MTable 8.5.5)
17) Additional Number of Urban Houscholds to be Served by
Municipal Solid Waste System in Phase I (MTable 8.5.6)
18) Water Supply Facilities Requarcd by Target Year (MTable 8.6.1)
19) Sanitation Facilities Required by Target Year {(MTable 8.6.2)
20) Number of Garbage Collection Trucks Required in Phase | (MTable 8.6.3)
21) Estimation of Base Year Service Coverage of Water Supply (STable 8.2.1)
22) Population Coverage in Phase [ Provided by Served Populatlon
in the Base Year (STable $.2.2) ' 1.
23) Number of Houscholds Served by Sanitary Toilets in the ' &
Base Year (1994)(STable 8.2.3)
24) Number of Public School Student Served by Schoo! Toilets in the



Base Year (ST 'ablc 8. 2 A)
25) Number of Public Utilities with Sanitary Toilets in the
Base Year (1994) (?Tablc 8.25) . .
206) Houscholds' Cow:ragc in Phasc | Prowdgd by Existing Facilities in the
Base Year (Houschold 1 micts) (STable 8.2.6) - -
27) Public School and Public Coverage in Phase | Provided by
Existing Facilities'in the Base Year (STablec'8.2.7)
28) Census Populalion and Projected Population (STable 8.3.3)
29) Municipal/City Population Projcction (STable 8.3.4)
30) Municipal/City Population for the Year 2010 and Estimate
Growth Rates (STable 8.3.5) - ‘
31) Past and Projected Population by Cumnl Mumcnpahlnyuy (S’I‘ablc 8.3.0)
12) Past Poputation Dcvclopment by Urban and Rural Ar¢a (STable 8.3.7)
33) Population Projected by Urban and Rural Area (STablc 8.3.8)
34) Past and Projected Popualallon by Urban and Rural Area of Cum nt
Municipality/City (STable 8.3. 9
35) Projected School Enrollment by Mumc:pahty by Target Year (S’] ‘able 8§.3. 6)
36) Projected Number of Public Utilities by Municipality by Target Year (STable 8.3.7)
37) Population to be Served by Level I System in Phasc ¥ {STable 8.5.1)
38) Population to be Served in Phase I (Water Supply) (STable 8.5.2)
39) Population to be Served in Phase Il (Water Supply) (STablc 8.5.3)
40) Additional Numbgr of Houscholds to be Served in
Phase [ (Houschold Foiléts) (STable 8.5.4)
41) Additional Number of Households to be Served in
Phasc 11 (Houschold Tonlels) (STable 8. 5.5) :
42) Additional Number of Pubtic School Studeits to be Served i in
Phase 1 and I (School Toilets) (STable 8.5.6) -
43) Additiona) Number of Public Ullllilﬁb wnh S'arulary I‘01lcts in
Phase I and IT (STable 8.5.7) .
44) Urban Water Supply Facilities Requlred by l‘arget Ycar (STabIe 8 6. 1)
45) Plan for Expansion of Emstmg Levet IIT System (STable 8.6 2)
46) Rural Water Supply Facilities Required by Target Year (STable 8.6.3)a)
47) Rural Water Supply Facililics Required by Target Year (STable 8.6.3)(b)
48) Urban Houschold Toilets Required by Target Year (STable 8.6.4)
" 49) Rural Household Toilet Required by Target Year (STable 8.6.5)
50) Public Schooi Toilets Required by Target Year (STable 8.6.6)
51) Public Toilets Required by Target Year (STable 8.6.7)

6) Cost Es!q‘mate& Jor Future Sector Development (chapter-10.xls) -

. a) Price of Major Materials by Facilities (MTable 10.2.1)
b) Construction Cost of Water Supply Facilitics Required for
Phase 1 (Z003) (MTable 10.3.1)
¢) Breakdown of Community Development and Trammg Cost (M lablc 10.4. 1)
d} Unit Cost of Level 1 {Gravel Packed Deep Weli -- 40m Depth) (STable 10.2.23)
¢) Unit Cost of Level I (Natural Gravel Packed Deep Well-40m Dcpth)(STab]e
16.2.2.b)

f) Unit Cost of Level I (Gravel Packed Deep Well - 80m Depth) (S’l able lO 23, a) o
g) Unit Cost of Level 1 {(Natural Gravel Packed Deep Well-80m Deplh)(%] able
10.2.3.b) .

h) Unit Cost of Level I (Gravel Packed Deep Well - 120 Depth) (STable 10.2.4)

i) Unit Cost of Level I(Natural Gravel. Packed Deecp Well-120m Depth)(STable
10.24b)

1) Unit Cost of Level I (Deep Well Rehabilitation ) (STable 10.2.5)



k) Unit Cost of Level T{Shallow Well - 18m Depth) (STablc 10.2.6)

1} Unit Cost of Level 1{Spring Development) (STable 10.2.7)

m) Unit Cost of Level 1T (600 Service Population) (STable 10.2.8)

n} Unit Cost of Level HE (5,000 Scivice Population) (STable 10.2.9).

0) Unil Cost of Level 111 (10,000 Service Population) {(STable 10.2.10)

p) Unit Cost of Level 11 (15,000 Service Population) STable 10.2,11) .

q) Unit Cost of Flush Water Sealed wuth Septic Tank Toilet (STable 10.2.12)
r) Unit Cost of Pour Flush with Double Pit Latrine (STable 10.2.13)

s) Unit Construction Cot of Ventilated Improve Pit Latrine (STable 10.2.14)
1) Unit Construction Cost of Pit Latrine (STable 10.2.15) -

u) Unit Cost of School Toilet (STable 10.2.16)

v) Unit Cost of Public Toilet (STable 10.2.17)

w) Cosl of New Laboratory {(STable 10.2.18)

x) Cost of Upgrading Laboratory (STable 10.2. 19)

y) Construction Cost of Water Supply Facilities Required for Phasc Il (STablc 10.3.2)
z} Cost of Sanitation Facilitics Required for Phase I (STable 10.3.3)

aa) Cost of Sanitation Faeilitics Required for Phasc }{ (STablc 10.3.4) .

T} Financial Armngemén!k‘ {chap-11.xis)

a) Projected Internal Revenue Allotment for Medium-Term
Sector Development (MTable 11.2.1) ‘
b} Projected Allotment of IRA to the Relevant Sector by
Component, 1996-2000 (MTable 11.2 2 ‘
¢) Financing Requirerents. by Sector Component for the Provmce (MTab'rc 11.3.1)
d} Additional Fund Reqmremcnl for Medium-Term Plan (MTable 11.3.2)
¢} futermal Revenue Allotment for Water Supply and Sanitation Sector g
by Munigcipality (Medium-Tenm Development 1996-2000) (M Table 11 3 3)
f) Relationship between Funding Levels and Percent of Coverage
for Water Supply Scclor (MFlgure 11.4.1)
2) Relahonship between B unding Levels and Percent of Coveragc
for Sanitation Sector (MFigure 142)
h} Municipal Investment Need Rankmg for Urban Water Supply (MT’lble 1 l 4.1)
i) Distribution of Provincial IRA to Mumc;pahty for
Urban Water Supply (MTable 11.4.2) o
j} Municipal Investment Need Rankmg (MTablc 1l 4. 3
k) Percentages for Annual Investment (STable 11.3.1) . Do '
1} Comprehensive lnvcstment Necd Ranking of the Mumcnpalmes (STable 11.4.1)
m) New Cost Sharmg Arrangement Between NG and LGUs (MTable 11.5.1)
n) GOP- Assusled Level 1 Water Supply and Sanitation Project Cost (MTable 11.5.2)
0) Cost Sharing for the Project 9Case 1): 1997 Price Level (MTable 11.5.3)
p) Cost Sharing for the Project (Case 2): (MTable 11.54)
Q) Available IRA for GOP-Assisted Level I Water Supply and Sanitation Pro;ecl for
- Eligible Municipalities (STable 11.5.1)
r) Available 1RA for GOP-Assisted Urban Sanitation Project for Eligible
Municipalities {STable 11.5.2)
s) Total Available IRA for GOP-Assisted Level I Water Supply and Sanitation
Project (STable 11.5.3)
t) Investment Program of GOP-Assisted Level ] Water Supply and Sanitation
Project (STable 11.6.1)
u) O&M Cost for Level  Facilities (STable 11.6.2) @
. v)O&M Cost per HH/Month by Facility and Proporllon to Monthly Famlly
Income (STable 11.6.3)



w) Family Income (_STaBlc 11.6.4) ;
x} O&M Cost for Rural Sanitation (STablc 11.6.5)
¥) O&M Cost for Urban Sanitation (STable 11.6.6)

7. DATA FILES LINKAGES

Linkages ave logical connection between records in'the data files. Through linkages, once the user’s
updates the source data, all data in the streams of linkages are dynamically updated. Linkages arc the
convenicnt tools of updaiihg rclated data, these also shictd the user’s from the complexity of formula

manipulation. With the aid of the data linkages the user’s can concentrate more in validating the

source data,

The following table lists the logical conneetions for cach worksheel.
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